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Prima Lezione: Costruire una mappa 

I tipi di informazione geografica disponibili, navigazione nella mappa, 
coordinate e scala, vista panoramica 

 

Introduzione 
Il GIS è un argomento non molto noto, che offre grandi possibilità pratiche in molti settori. GIS è 
l'acronimo di Sistema Informativo Geografico (Geographical Information System), in italiano 
spesso anche chiamato Sistema Informativo Territoriale (SIT), un sistema informativo 
computerizzato che permette l'acquisizione, la registrazione, l'analisi, la visualizzazione e la 
restituzione di informazioni derivanti da dati geografici. Si tratta di un sistema informatico in grado 
di produrre, gestire e analizzare dati spaziali associando a ciascun elemento geografico una o più 
informazioni. 

Un programma GIS, componente essenziale del sistema, è quindi un insieme organico di 
componenti per il trattamento di immagini di varia natura e delle informazioni ad esse associate. I 
moderni GIS possono eseguire analisi molto sofisticate, ed il termine geografico non deve trarre in 
inganno circa gli ambiti delle possibili applicazioni. Fra gli utilizzatori di programmi GIS troviamo 
scuole, amministrazioni locali, regionali, statali, uffici tecnici, aziende pubbliche e private operanti 
in campi molto diversi fra loro (ad esempio, la tutela ambientale e la gestione di un'azienda di 
trasporti). Quando è necessario disporre di uno strumento per la gestione del territorio, un 
programma GIS è la logica soluzione. 

Fino a ieri i programmi GIS erano molto costosi e difficili da utilizzare; richiedevano inoltre 
computer di notevole potenza, oggi è invece possibile trovare programmi che girano su normali PC 
e non richiedono conoscenze particolare per essere utilizzati. 

 

Carte tematiche e database 
Tramite un programma GIS, l'utilizzatore è in grado di visualizzare e sovrapporre diverse carte 
tematiche di una determinata zona, garantendo la corrispondenza delle coordinate geografiche, della 
scala e quindi delle distanze. I temi possono essere immagini, ad esempio es. foto aeree e satellitari 
(detti dati raster) o disegni, ad es. punti di riferimento, curve di livello, limiti geologici, limiti 
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amministrativi (detti dati vettoriali), vedi in dettaglio a pagina 4. Gli elementi dei temi vettoriali 
sono associati a tabelle di dati (database di attributi) sui quali si possono effettuare ricerche. Anche 
testi e immagini si possono associare ai vari elementi. 

E' possibile creare nuovi temi personalizzati dall'interazione degli elementi di diversi temi 
attraverso operazioni di vario tipo (es. ritagliare i tipi geologici contenuti all'interno di un 
determinato limite amministrativo). Queste operazioni possono essere estese alle informazioni 
associate. 

 

 

Coordinate e Sistemi di riferimento geografico (proiezioni) 
La terra non è piatta, ma è rappresentabile da una forma tondeggiante abbastanza complessa, 
chiamata geoide. Per poter rappresentare questa forma su un piano (una mappa cartacea o lo 
schermo di un computer) sono necessarie operazioni matematiche, dette proiezioni. Per sistema di 
proiezione si intende il modo in cui un oggetto sulla superficie terrestre viene rappresentato su un 
piano cartesiano. Fra i più usati ci sono il sistema latitudine-longitudine, espresso in gradi (di solito 
associato col sistema di riferimento WGS84, termine con cui viene a volte chiamato), la proiezione 
Universale Trasversa di Mercatore, detta UTM (diviso per fusi in base alla longitudine ed espresso 
in metri); in Italia è diffusa anche una proiezione simile all'UTM, detta Gauss-Boaga (anch'essa usa 
come unità di misura i metri). Ogni proiezione implica una distorsione, più o meno accentuata, dei 
dati rappresentati. 

Un GIS memorizza la posizione del dato impiegando un sistema di proiezione e di coordinate che 
definisce la posizione geografica dell'oggetto.  

L'Italia ricade sui fusi UTM 32 (parte occidentale) e fuso 33 (parte orientale) e per una parte della 
Puglia nel fuso 34 . I meridiani centrali dei fusi 32 e 33 sono il 9° ed il 15°. 
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Il GIS è anche in grado di gestire contemporaneamente dati provenienti da diversi sistemi di 
proiezione e riferimento, e di effettuare conversioni fra i vari sistemi. A differenza della cartografia 
su carta, la scala in un GIS non indica la scala di visualizzazione (infatti in qualunque GIS è 
possibile ingrandire a piacimento le varie porzioni di territorio), ma evidenzia la qualità del dato 
(indica cioé la scala ottimale alla quale visualizzare il dato, senza metterne in evidenza le 
imperfezioni). 
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Tipi di dati geografici 
Il mondo reale può essere rappresentato in un sistema informativo geografico attraverso due tipi 
principali di dato: il dato vettoriale e il dato raster. 

dati vettoriali 
I dati vettoriali sono costituiti da elementi semplici quali punti, linee e poligoni, codificati e 
memorizzati sulla base delle loro coordinate. Un punto viene individuato attraverso le sue 
coordinate reali (x1, y1); una linea o un poligono attraverso la posizione dei sui vertici (x1, y1; x2, 
y2; ...). A ciascun elemento (punto, linea o poligono) è legato un record della tabella associata che 
contiene tutti le informazioni dell'oggetto rappresentato (ad esempio al poligono dei confini 
comunali di Roma sarà collegata una riga della tabella dei dati che riporta il nome del comune, il 
numero di abitanti e altre informazioni relative). 

 

 

 

I dati vettoriali hanno tre caratteristiche: 

Geometriche: relative alla rappresentazione cartografica degli oggetti rappresentati; quali la forma 
(punto, linea, poligono), la dimensione e la posizione geografica; 
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Topologiche: riferite alle relazioni reciproche tra gli oggetti (connessione, adiacenza, inclusione 
ecc…); 

Informative : riguardanti i dati (numeri, testi ecc…) associati ad ogni oggetto. 

 

 

 

 

 

Fra i molti formati vettoriali disponibili, il più diffuso è senz'altro lo shapefile (detto anche shape, o 
shp), tanto che è oggi uno standard di fatto. Si tratta di un formato piuttosto semplice, inventato da 
un'azienda privata, ma reso pubblico in modo che moltissimi programmi diversi lo potessero 
leggere e scrivere. Si compone di vari files, tutti con lo stesso nome, ma con diversa estensione; ad 
esempio, lo shapefile “Parchi” presente fra i dati delle esercitazioni si compone di: Parchi.shp (dove 
stanno le informazioni geometriche, ovvero il disegno), Parchi.dbf (una tabella di dati associati ad 
ogni elemento geometrico), Parchi.shx (un indice per consentire la lettura rapida del file), e 
eventualmente alcuni files accessori: Parchi.prj (dove sono scritte le informazioni sulle proiezioni 
geografiche), Parchi.sbx e Parchi.sbn. Attenzione: per copiare uno shapefile da una cartella all'altra 
è necessario copiare tutti i files con lo stesso nome; copiare solo il file .shp non ne consente la 
lettura. 

dati raster 
Il dato raster permette di rappresentare il mondo reale attraverso una matrice di celle, generalmente 
di forma quadrata o rettangolare, dette pixel. A ciascun pixel è associato il valore che il parametro su 
cui è costruita la mappa assume in quel determinato rettangolo di territorio (es. altitudine oppure 
pendenza). La dimensione del pixel (detta anche pixel size), generalmente espressa nell'unità di 
misura della carta (metri, chilometri etc.), è in stretta relazione con la precisione del dato. 
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I dati vettoriali e i dati raster sono adatti ad usi diversi. La cartografia vettoriale è particolarmente 
utile per la rappresentazione di dati che variano in modo discreto (ad esempio l'ubicazione dei 
cassonetti dei rifiuti di una città o la rappresentazione delle strade o una carta dell'uso del suolo), la 
cartografia raster è più adatta alla rappresentazione di dati con variabilità continua (ad esempio la 
mappa dell'altitudine, detta anche modello digitale di elevazione o una carta di acclività del 
versante). 
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Dal GIS al Web-GIS 
Le informazioni geografiche, fino a pochi anni fa limitate all'uso specialistico, sono ormai in gran 
parte disponibili tramite Internet, che si sta rivelando, anche oltre le migliori aspettative iniziali, il 
mezzo migliore per la loro diffusione. Oggi è infatti possibile consultare in rete una grande quantità 
di informazioni, a partire dalle mappe di base (presenti ad esempio in Google Maps), fino a servizi 
molto specializzati. 

 

 

 

 

 

Fra i servizi disponibili ci sono quelli di ricerca di località, di definizione di itinerari, e di 
consultazione di dati specifici (come ad esempio i piani regolatori delle Amministrazioni 
Comunali). 

 

I webGIS non hanno tutte le funzionalità di un GIS installato su un personal computer, ma rendono 
disponibili in modo facile una serie impressionante di informazioni, senza il bisogno di acquisire ed 
eventualmente convertire i dati; d'altro lato, non consentono un controllo sulla effettiva gestione dei 
dati, e mostrano notevoli limitazioni operative. 
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In generale, tutti i vari servizi webGIS sono basati su uno o più server che, interrogando una base di 
dati sulla base delle richieste dell'utente, forniscono la mappa, visualizzata all'interno di un comune 
browser (come ad esempio FireFox). Fino a qualche anno fa la consultazione richiedeva estensioni 
del browser (detti plugins) specializzati, ma oggi questo si verifica molto raramente. Oggi è anche 
possibile aggiornare i dati presenti su server remoti (se si dispone dei privilegi sufficienti) anche 
dalla propria postazione di lavoro, purché collegata ad internet. 

 

Esempi interessanti si trovano sul sito di OpenLayers, uno dei webGIS Open Source più potenti ed 
efficaci, e in particolare sulle pagine: 

http://openlayers.org/gallery/ e http://openlayers.org/dev/examples/. 

 

Si possono vedere e provare ad esempio: 

� una versione completamente accessibile anche ai portatori di handicap, tramite menù 
semplificati e comandabili anche da tastiera 

� una versione che consente di selezionare diverse cartografie, provenienti da Google Maps, 
Virtual Earth, Yahoo ecc. 
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� una con la possibilità di inserire online punti, linee e poligoni 

 

 

� una versione che consente di effettuare elaborazioni online, ad esempio la creazione di fasce 
di rispetto 
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Applicazioni webGIS sono abbondantissime su Internet, e potranno essere esplorate per 
esercitazione. 

Inoltre, una possibilità interessante è quella di visualizzare, tramite il proprio programma GIS, 
installato quindi sul proprio computer e contenente i propri dati, anche dati provenienti da server 
disponibili su internet. Questo è reso possibile dall'esistenza di standard (in particolare web map 
service o WMS e web feature service o WFS) tramite i quali programmi diversi possono scambiarsi 
dati in modo semplice. Si potranno ad esempio visualizzare i dati raccolti in un progetto scolastico 
di rilevamento delle farmacie, delle scuole, e di altre strutture del proprio comune (ossia dati 
puntiformi inseriti da noi) con lo sfondo della cartografia regionale o italiana o mondiale resa 
disponibile da server  su internet. 

Database geografico 
La necessità di archiviare grandi moli di dati in maniera condivisibile (per lettura e/o modifica) ha 
trovato una soluzione nell'utilizzo di database geografici. Rispetto ai database tradizionali, nei 
database geografici è contenuta anche la geometria degli oggetti e non più solo gli attributi. Questa 
caratteristica abbinata alla potenza dei motori dei database, consente di accedere velocemente a 
grandi quantità di dati.  
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 QuantumGIS 
 

QuantumGIS (QGIS) (www.qgis.org) è un software GIS Open Source (è quindi possibile copiarlo e 
distribuirlo in perfetta legalità) che permette di visualizzare, interrogare, modificare carte, creare 
stampe ed effettuare semplici analisi spaziali. QGIS, usato come interfaccia del più potente software 
GIS Open Source GRASS (http://grass.osgeo.org), permette di realizzare le più disparate e 
complesse operazioni di analisi geografica quali la modellistica spaziale e l'analisi di immagini 
satellitari. 

Nota bene: il programma è in continua evoluzione, e versioni migliorate escono ogni pochi mesi. 
Vi invitiamo a scaricare l'ultima versione dal sito web. 

Per avviare QGIS, dopo aver seguito le semplici operazioni di installazioni come riportate nel 
relativo manuale e dopo aver copiato sul vostro computer i dati di esempio contenuti nel CD, 
cliccate sulla icona QGIS presente sul vostro desktop. 

All'avvio di QGIS, viene caricata una schermata principale (i numeri in blu, da 1 a 6, riportati in 
figura rappresentano le 6 sezioni principali dell'interfaccia). 

 

 

 

 

L'interfaccia di QGIS può essere suddivisa in sei sezioni: 
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1. Barra del menù 
La barra del menù fornisce accesso alle varie funzioni di QGIS utilizzando un menù a 
tendina. I menù di alto livello ed un indice di alcune delle funzioni fornite sono riportate nel 
manuale di QuantumGIS allegato. 
Ogni barra può essere posizionata a piacimento. Inoltre ogni barra può essere eliminata e 
reinserita, cliccando con il tasto destro del mouse e selezionando la voce corrispondente sul 
menù a tendina che si aprirà. 

2. Barra degli strumenti 
La barra degli strumenti fornisce l'accesso alla maggior parte delle funzioni, più le funzioni 
supplementari per l'interazione con la mappa. Ogni elemento della barra degli strumenti ha 
una guida nel popup relativo. Tenete il vostro mouse sopra l'elemento e verrà visualizzata 
una breve descrizione della sua funzionalità.  

3. Legenda 
L'area della legenda è usata per regolare la visibilità e la disposizione "z" degli strati (in 
gergo chiamati layer). Con disposizione "z" si intende l'ordine di sovrapposizione degli 
strati: uno strato posto in alto copre quelli posti sotto di lui. Il quadratino accanto al nome di 
ogni strato nella legenda serve per mostrare/nascondere quello strato.  
Il contenuto del menù relativo ad ogni strato caricato è attivabile con il tasto destro e il suo 
contenuto varia tra dati vettoriali e raster. 

4. Area di mappa 
Questa è l'area in cui le mappe vengono visualizzate. La mappa che appare in questa finestra 
è il risultato della sovrapposizione degli strati vettoriali e raster che avete scelto di caricare e 
rendere visibili (vedere le sezioni che seguono per ulteriori informazioni su come caricare i 
livelli). La zona di visualizzazione della mappa può essere spostata ed è possibile effettuare 
operazioni di zoom in ed out (+ e -). La vista nell'area di mappa e la legenda sono 
strettamente legate l'una all'altra - le mappe che vengono visualizzate riflettono i 
cambiamenti che fate nella zona della legenda. 

5. Mappa panoramica 
La panoramica della mappa fornisce una vista completa dei livelli aggiunti ad essa. 
All'interno della panoramica c'è un rettangolo che mostra l'estensione corrente della mappa. 
Ciò vi permette di determinare rapidamente quale area della mappa state attualmente 
osservando. Si noti che le etichette non sono restituite alla panoramica della mappa anche se 
i livelli hanno la funzione di visualizzazione delle etichette attiva. Potete aggiungere un 
singolo livello alla mappa panoramica facendo click col tasto destro su di esso nella legenda 
e scegliendo poi Aggiungi alla mappa panoramica. Potete anche aggiungere o rimuovere 
tutti i livelli nella panoramica usando lo Strumento di panoramica nella barra degli 
strumenti. E' possibile anche spostare, con il mouse, il rettangolo rosso che mostra la tua 
estensione di visualizzazione attuale, la mappa visualizzata si modifica in accordo con 
questa operazione. 

6. Barra di stato 
La barra di stato vi mostra la posizione del punto che state indicando con il mouse in base 
alle coordinate della mappa (per esempio metri o gradi decimali)  La barra di stato inoltre 
mostra il cambiamento di estensione della vista della mappa quando utilizzate lo strumento 
zoom e pan. Nella parte destra della barra di stato c'è un quadratino; cliccandoci si 
impedisce che i livelli siano ridisegnati nella panoramica quadro di mappa ad ogni 
cambiamento delle proprietà od aggiunta di uno strato. Alla destra nella parte più lontana 
della barra di stato c'è un'icona a forma di proiettore. Facendo click su questa si aprono le 
proprietà relative alla proiezione per il progetto in corso. 
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Impostazione opzioni base 
Visto che lavoreremo con dati associati al sistema di proiezione UTM EDL79 che ha come unità di 
misura associata il metro lineare è opportuno, prima di iniziare a caricare dati geografici, dare a 
QGIS questa informazione. 

QGIS è in grado di riconoscere il sistema di proiezione associato ai dati geografici caricati se questi 
ne sono in possesso, sarà sufficiente quindi solo definire l'unità di mappa scegliendo sulla Barra del 
menù il percorso menù Impostazioni → Proprietà del progetto e scegliendo l'opzione Metri  nella 
sezione Unità di mappa relativa alla linguetta Generale nella finestra che si aprirà. 

 

 

 

 

Tale operazione dovrà essere eseguita ad ogni apertura di QGIS a meno che non si carichi un 
progetto di lavoro precedentemente salvato dopo aver eseguito tale procedura. 
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Caricare i dati cartografici 

dati vettoriali 
Per caricare un dato vettoriale (quale uno shapefile od altri formati supportati da QGIS) si clicca 

sull'icona Aggiungi un layer vettoriale  oppure selezione dalla Barra del menù il percorso 
Layer → Aggiungi un layer vettoriale. La finestra per la ricerca del file che si aprirà dovrà essere 
usata per selezionare il file Comuni_Lazio.shp contenuto nella cartella dati. 

Dopo aver selezionato il dato e cliccato su Open il dato vettoriale relativo alla rappresentazione 
cartografica dei comuni della Regione Lazio apparirà sulla schermata principale. 

 

 

 

 

 

Il colore associato alla cartografia sarà casuale e verrà illustrato nella seconda lezione come 
modificare le proprietà di visualizzazione. Con lo stesso metodo potranno essere visualizzati gli 
altri dati vettoriali shape contenuti nella stessa cartella. 

Ripetere l'operazione con lo strato Fiumi_Principali.shp per caricare anche lo strato relativo 
all'idrografia principale della Regione Lazio. 
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dati raster 
Per caricare un dato raster (quale un Arc/Info Binary Grid od altri formati supportati da QGIS) si 

clicca sull'icona Aggiungi un raster  oppure selezione dalla Barra del menù il percorso 
Layer → Aggiungi un raster. La finestra per la ricerca del file che si aprirà dovrà essere usata per 
selezionare il raster w001001.adf contenuto nella cartella dei dati d'esempio e visualizzabile dopo 
aver selezionato nella sezione Files of type della finestra la voce GRASS, AIG e per tutti gli altri 
files (*). 
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Dopo aver selezionato il dato e cliccato su Open il dato raster relativo alla rappresentazione 
cartografica delle classi altimetriche (DEM) della Regione Lazio apparirà sulla schermata 
principale. 

Il colore associato alla cartografia sarà in scala di grigi con fondo nero; nella terza lezione verrà 
illustrato come modificare le proprietà di visualizzazione. 

 

 

 

Rimozione, attivazione/disattivazione e disposizione degli strati geografici 
Al momento attuale l'unico strato visibile sarà quello raster che coprirà gli strati sottostanti. Per 
rimuovere tale strato dalla legenda e quindi dalla mappa cliccare con il tasto destro del mouse sul 
nome dello strato e scegliere la voce Rimuovi. 
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Ricarichiamo il raster w001001 e vediamo come spostare tale strato in fondo alla stratificazione 
attuale: trascinare, tenendo premuto il tasto sinistro del mouse sul nome dello strato, lo strato raster 
DEM (w001001) in fondo alla lista della legenda. Effettuata questa operazione saranno visibili, 
sullo sfondo nero del raster, il vettore dei comuni e, sovrastante, quello dell'idrografia principale. 

 

 

 

Per disattivare la visualizzazione di uno strato, lasciando lo strato caricato in legenda, è sufficiente 
cliccare sulla casella con crocetta alla sinistra del nome dello strato sulla legenda. La casella perderà 
così la spuntatura e lo strato corrispondente sparirà dalla mappa. L'operazione è reversibile 
spuntando nuovamente il quadratino. 

Effettuare questa operazione per lo strato Comuni_Lazio in modo da visualizzare in seguito 
esclusivamente lo strato raster DEM con sovrapposti i fiumi principali della regione. 
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La scala di mappa e le coordinate 
Nella barra di stato che ricordiamo si trova in basso a destra rispetto all'area di mappa possiamo 
individuare il box Scale1 che ci fornisce indicazioni sulla scala attuale di visualizzazione ed un 
ulteriore box alla sua destra che ci fornisce le coordinate x,y (in metri lineari) della posizione del 
mouse quando questo si sposta sull'area di mappa. 

Spostare il mouse sull'area di mappa per vedere come le coordinate x,y cambiano nel box sopra 
descritto. 

Navigare nella mappa 
Per effettuare operazioni di zoom in (ingrandimento) sulla mappa visualizzata è possibile cliccare 

sull'icona Ingrandisci  presente nella Barra dei menù, il puntatore del mouse passerà dalla 
forma a 'mano' alla forma di 'lente di ingrandimento con un + all'interno'. Sarà possibile a questo 
punto effettuare uno zoom sull'area desiderata disegnando un quadrilatero intorno all'area stessa 
tenendo premuto il tasto sistro del mouse. Al rilascio del tasto nell'area di mappa verrà visualizzata 
l'area prescelta. 

Per effettuare operazioni di zoom out (diminuzione) sulla mappa visualizzata è possibile cliccare 

sull'icona Rimpicciolisci  presente nella Barra dei menù, il puntatore del mouse passerà alla 
forma di 'lente di ingrandimento con un - all'interno'. Sarà possibile a questo punto effettuare una 
riduzione sull'area desiderata cliccando direttamente sulla mappa con il tasto sinistro o disegnando 
un rettangolo seguendo la stessa procedura prima descritta. Il centro della nuova area di 
visualizzazione sarà il punto in cui abbiamo fatto il semplice click o il centro del rettangolo 
disegnato. 

Per zoomare ad una scala definita sarà sufficiente impostare il valore della nuova scala direttamente 
nel box Scale e premere Invio. La mappa sarà visualizzata alla scala prescelta mentre il centro della 
mappa rimarrà quello precedente a tale operazione. 

Provare ad impostare la scala al valore 1:100.000 e visualizzare il risultato. 

 

 
 

                                                 
1 NB: al momento della preparazione di queste lezioni, la traduzione italiana di questa versione del programma non è 

ancora completa. 
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Per spostarsi sull'area di mappa è possibile cliccare sull'icona Sposta mappa  e, tenendo 
premuto il tasto sinistro del mouse, trascinare la mappa stessa per visualizzare l'area desiderata. 

Per visualizzare la mappa all'estensione di un singolo strato occorre selezionare il nome dello strato 

sulla legenda e cliccare sull'icona Zoom sul layer , la nuova area di mappa permetterà di 
visualizzare l'intero strato. 

Per visualizzare ad un'estensione che permetta di vedere tutti gli strati caricati in legenda è 

sufficiente cliccare sull'icona Vista massima . L'area di mappa mostrerà a questo punto tutti gli 
strati caricati (DEM e Fiumi_Principali). Si noterà che l'area di mappa corrisponde all'estensione del 
raster DEM che permette di visualizzare tutti gli strati in legenda. 

L'icona Ultimo zoom  permette di reimpostare l'area di mappa precedente all'ultima operazione 

di zoom o spostamento effettuata, mentre l'icona Aggiorna  permette di fare un aggiornamento 
del disegno. 

Mappa panoramica 
Il box in basso a sinistra mostra la mappa panoramica che permette di capire la posizione dell'area 
di mappa rispetto all'estensione massima dell'area occupata dai singoli strati. 

Inizialmente la mappa panoramica appare vuota, per caricarvi gli strati in legenda è sufficiente 

selezionare lo strato scelto sulla legenda e cliccare sull'icona Nella vista panoramica  oppure 
cliccare sul nome dello strato con il tasto destro e scegliere la voce Show in overview. Lo strato 
prescelto apparirà nella mappa panoramica. 

Il box rosso visualizzato rappresenta l'area visualizzata nella finestra principale di mappa, sarà 
sufficiente effettuare semplice operazioni di zoom o di spostamento per vedere la variazione del box 
rosso nella mappa panoramica. Una funzione interessante è data dal poter spostare il box rosso nella 
mappa panoramica, tenendo premuto il tasto sinistro del mouse e trascinandolo, per potersi spostare 
tra zone diverse della mappa senza cambiare il livello di zoom. 
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Seconda Lezione: Lavorare su una mappa 

Misurazioni, dati associati; salvare e riaprire un progetto; elementi decorativi 
 

Avviare QGIS e impostare l'unita di misura in metri lineari (vedi prima lezione). Caricare in 
sequenza il raster DEM w001001.adf e gli strati vettoriali Comuni_Lazio.shp, Località_abitate.shp 
e Fiumi_Principali.shp contenuti nella cartella dei dati di esempio. 

Misurazioni 
Una volta caricati gli strati geografici e impostata l'appropriata unità di misura (metri) è possibile 
eseguire misure interattive sulla mappa. 

Attivando l'icona Misura linea  il puntatore si trasformerà in una croce e apparirà una finestra 
che ci permetterà di conoscere le misure parziali e totali delle distanze sulla mappa, nell'unità di 
misura più appropriata (metri per le piccole superfici, chilometri per quelle più ampie). Cliccando 
con il tasto sinistro del mouse sulla mappa sarà possibile creare elementi lineari, ognuno intervallato 
da un click del mouse, di cui apparirà, di volta in volta, la misura parziale sulla finestra attivata. 

Per effettuare l'ultima misurazione consecutiva e terminare l'operazione si clicca sulla mappa con il 
tasto destro, avremo così la misura parziale dei singoli segmenti lineari e la misura totale di tutti i 
segmenti. Cliccando sul tasto Chiudi  sulla finestra attiva si uscirà dalla funzione Misura linea. 
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Per esercitazione, basandosi sullo strato Località_abitate, misurate la distanza tra il centro della città 
di Roma e la costa oppure tra Roma e i confine più a nord della Regione Lazio. 

E' possibile anche misurare in modo interattivo aree sulla mappa cliccando sull'icona Calcola l'area 

. Si aprirà una finestra di misura che darà informazioni in tempo reale sulla dimensione dell'area 
che disegnerete con il mouse. Con il tasto sinistro del mouse potrete determinare i vertici della 
figura geometrica di cui volete conoscere l'area; potete terminare la misura cliccando con il tasto 
destro sull'ultimo vertice del vostro poligono. 

 

 

Nella finestra attiva avremo quindi la misura dell'area della figura appena disegnata, cliccando sul 
tasto Chiudi  di tale finestra si uscirà dalla funzione Calcola l'area. 

Dati associati 
Come abbiamo descritto nella prima lezione, ogni dato geografico è associato ad una serie di 
informazioni più o meno complesse. 

I dati vettoriali sono associati ad una tabella (un semplice foglio di calcolo o una tabella in un 
complesso database) ed in particolare ogni elemento del dato vettoriale (es. i singoli comuni dello 
strato Comuni_Lazio) è associato ad una riga, o record, nella tabella associata. 

Per visionare la tabella dei dati associati si seleziona il dato geografico vettoriale nella legenda e si 

clicca sull'icona Apri tabella  , si aprirà una nuova finestra che permetterà di visualizzare il 
contenuto della tabella e quindi tutte le informazioni associate ad ogni singolo elemento del dato 
vettoriale in esame. 
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Chiudiamo la tabella e selezioniamo lo strato Comuni_Lazio nella legenda, per definire quale strato 

si vuole interrogare, e clicchiamo sull'icona Informazioni geometrie ; il puntatore del mouse 
assumerà la forma di una freccia con una 'i '. Cliccando sui singoli comuni i relativi poligoni si 
coloreranno e saranno contornati di rosso e si aprirà una finestra informativa che riporterà le 
informazioni contenuti nelle diverse colonne, o campi, dei relativi record nella tabella associata. 

 

Tra le informazioni sarà visualizzato il nome del Comune (campo FIRST_DZCO), il numero dei 
cittadini di sesso femminile residenti (campo SUM_FEMMIN), il numero dei cittadini di sesso 
maschile residenti (campo SUM_MASCHI) ed il totale generale della popolazione (SUM_TOT). 

Tale operazione è applicabile a tutti gli strati vettoriali presenti tra i dati di esempio. 

I dati raster non sono invece associati a tabelle, ma ogni quadratino (pixel) che costituisce 
l'immagine è associato ad un valore relativo all'informazione contenuta nel raster. Ad esempio il 
dato raster w001001 relativo alla carta dell'altimetria della Regione è costituito da una griglia dove 
le singole celle, o pixel, della maglia saranno associati al valore dell'altimetria in quel punto. 

Se si rende visibile lo strato raster caricato (rimuovendo o disattivando gli strati vettoriali 
sovrastanti), selezionando tale raster (w001001) nella legenda ed attivando l'icona Informazioni 
geometrie sarà possibile cliccare su un punto qualsiasi del raster, determinando l'apertura di una 
finestra che riporterà il valore del pixel selezionato e quindi l'altitudine di quel punto. 

 

E' possibile verificare che le zone montuose, più chiare, avranno valori più alti rispetto alle zone di 
pianura, più scure. Cliccando sullo sfondo nero avremo invece come risultato il valore 0. 
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Elementi decorativi 

freccia del nord 
E' possibile visualizzare nell'area di mappa alcuni elementi decorativi che arricchiscono la mappa di 
informazioni utili alla sua lettura e comprensione. 

In basso a sinistra all'interno dell'area di mappa è già attiva e visibile una rosa dei venti che indica i 
quattro punti cardinali con particolare attenzione per il Nord (N) la cui freccia è diretta verso l'alto 

come da corretta proiezione della carta. Cliccando sull'icona Freccia Nord  o seguendo il 
percorso Plugins → Decorazioni → Freccia Nord si apre la finestra relativa. 

 

 

 

 

In tale finestra è possibile: 

1. Attivare o disattivare la rosa dei venti cliccando sull'opzione Abilita la freccia nord 

2. Scegliere la sua posizione dall'opzione Posizionamento 

3. Scegliere che la direzione del nord sia impostata in modo automatico in base alla proiezione 
delle carte visualizzate oppure lo sia in modo manuale tramite l'opzione Seleziona 
automaticamente la direzione. 

4. Se la direzione viene impostata in modo manuale è possibile definirne una direzione 
impostando un'angolazione tramite l'opzione Angolo. 

Una volta effettuati le nuove impostazioni cliccare sul tasto Ok per visualizzare nell'area di mappa 
le modifiche apportate. 

 

etichetta di copyright 
L'altro elemento decorativo disponibile è l'etichetta di copyright (letteralmente “diritto di copia”, 
ovvero diritto d'autore), che serve per indicare il proprietario della mappa, che eventualmente pone 
dei limiti alla sua riproduzione; anch'essa è già presente nell'area di mappa in basso a destra con la 
scritta © QGIS 2008.  
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Cliccando sull'icona Etichetta copyright  o seguendo il percorso Plugins → Decorazioni → 
Etichetta copyright si apre la finestra relativa dove sarà possibile: 

1. Definire il contenuto dell'etichetta scrivendo direttamente il testo nel secondo riquadro e 
seguendo le istruzioni presenti nel primo riquadro. 

2. Scegliere la posizione dell'etichetta tramite l'opzione Posizionamento 

3. Scegliere il colore cliccando sull'opzione Colore e scegliendo il colore dall'apposita 
tavolozza. 

4. Scegliere se visualizzare o meno un'etichetta spuntando l'opzione Abilita etichetta di 
Copyright . 

 

 

 

Una volta effettuate le nuove impostazioni cliccare sul tasto Ok per visualizzare nell'area di mappa 
le modifiche apportate. 

 

I progetti 
Abbiamo visto che ogni volta che apriamo QGIS occorre ricaricare i dati geografici su cui vogliamo 
lavorare e impostare alcune opzioni di partenza quali l'unità di misura. Per evitare di fare questo ad 
ogni avvio, è possibile salvare la situazione relativa a quali dati sono stati caricati, la loro posizione 
reciproca o per esempio i colori a loro attribuiti salvando queste informazioni su un progetto che 
non è altro che un file di testo che ci permette di richiamare la situazione presente al momento del 
suo salvataggio ogni volta che lo vogliamo. 

Rendiamo quindi attivi tutti gli strati caricati all'inizio di questa lezione disponendoli dal basso 
verso l'alto in quest'ordine: raster dell'altitudine (w001001), vettore Comuni_Lazio, vettore 
Località_abitate e vettore Fiumi_Principali e clicchiamo infine sull'icona Vista massima. 
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A questo punto salviamo l'attuale stato di cose cliccando sull'icona Salva progetto  o Salva 

progetto con nome  o cerchiamo il percorso File → Salva progetto o File → Salva progetto 
con nome dalla Barra del menù. La finestra che si apre permetterà di decidere dove e con che 
nome salvare il progetto, niente di più di quello che facciamo quando salviamo un semplice 
documento di testo. Per creare un nuovo progetto e quindi pulire la legenda e l'area di mappa è 

sufficiente cliccare sull'icona Nuovo progetto  o cercare il percorso File → Nuovo progetto per 
ottenere una nuova base di partenza. Se si desidera ricaricare il progetto salvato è sufficiente 

cliccare sull'icona Carica progetto  o cercare il percorso File → Apri progetto ; si aprirà una 
finestra che permetterà di ricercare il file di progetto (che ricordiamo ha estensione .qgs) e di 
caricare il progetto desiderato. 
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Terza Lezione: Capire l'informazione geografica 

I dati associati; selezionare elementi a partire dalla loro posizione e dal valore 
dei dati associati. Personalizzare la mappa: attribuire colori, cartografia 

tematica in funzione dei dati associati 
 

I dati associati: selezionare elementi a partire da l loro valore  
Per iniziare, avviare QGIS, caricare il progetto salvato al termine della seconda lezione e disattivare 
lo strato raster w001001. 

Come abbiamo detto nella seconda lezione, i dati vettoriali sono associati ad una tabella (un 
semplice foglio di calcolo o una tabella in un complesso database) ed in particolare ogni elemento 
del dato vettoriale (es. i singoli comuni dello strato Comuni_Lazio) è associato ad una riga, o 
record, nella tabella. 

Per vedere la tabella dei dati associati si seleziona lo strato vettoriale nella legenda e si clicca 

sull'icona Apri tabella  , si aprirà una nuova finestra con il contenuto della tabella e quindi tutte 
le informazioni associate ad ogni singolo elemento del dato vettoriale in esame. 

Supponiamo ora di voler identificare nella mappa la località di Velletri dallo strato Località_abitate, 
abbiamo tre possibilità: 

1. conosciamo dove si trova geograficamente tale località e sappiamo riconoscerla in base alla 
forma 

2. interroghiamo tutti i poligoni dello strato fino a che non la troviamo, oppure 

3. utilizziamo la funzione di ricerca tramite la tabella associata. 

Per seguire la terza strada: selezioniamo lo strato vettoriale Località_abitate nella legenda ed 
apriamo la tabella associata tramite l'apposita icona. Scorrendo la tabella orizzontalmente possiamo 
vedere che esiste una colonna, o campo, di nome NOME_LOC dove compaiono tutti i nomi di 
località. Cliccando sul nome della colonna i record della tabella verranno ordinati secondo l'ordine 
alfabetico del suo contenuto. 
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Scorrendo la tabella in senso verticale troviamo la parola Velletri nel campo NOME_LOC e 
selezioniamo, cliccandovi sopra con il tasto sinistro del mouse, la riga corrispondente che 
ricordiamo è la riga, o record, contenente le informazioni associate al poligono relativo alla località 
Velletri. 

 

 

Chiudendo la tabella vedremo che sulla mappa il poligono corrispondente al record selezionato è 
stato a sua volta selezionato e risulta ora colorato di un giallo acceso. 

Cliccando sull'icona Zoom su selezione  o scegliendo la relativa voce dal percorso Visualizza 
→ Zoom su selezione dalla Barra del menù l'estensione dell'area di mappa andrà a coincidere con 
il poligono relativo alla località di Velletri. 

 

 

 

Poniamo adesso, ad esempio, di voler selezionare tutti i poligoni relativi alle località abitate del 
comune di Viterbo, potremo agire allo stesso modo andando ad ordinare la tabella in ordine 
alfabetico rispetto al campo NOME_COM e selezionando tutti i record che hanno la parola 'Viterbo' 
nel campo in oggetto. 

E' possibile effettuare una semplice interrogazione nella tabella in modo da trovare in modo 
automatico tutti i record che contengono un determinato contenuto in un determinato campo.  

In basso a sinistra nella tabella c'è un riquadro con scritto accanto Cerca per:, riempiamo questo 
campo con la parola 'VITERBO', scegliamo nella finestra a tendina alla destra del riquadro il campo 
su cui effettuare la ricerca quale NOME_COM e clicchiamo sul tasto Cerca. 
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Apparirà una piccola finestra che ci dirà che sono stati individuati 29 poligoni che contengono la 
parola 'VITERBO' nel campo NOME_COM nelle informazioni a loro associate (“Found 29 
matching feautures”). Clicchiamo sul tasto OK  per chiudere tale finestra. 

Per visualizzare i record selezionati clicchiamo sull'icona Muovi selezione in alto  che si trova 
in seconda posizione in alto a sinistra nella finestra della tabella. Tutti i record selezionati saranno 
portati in cima alla tabella e sarà possibile consultarne il contenuto. 

Se chiudiamo la tabella vedremo che sulla mappa i poligoni corrispondenti ai record selezionati 
sono stati anch'essi selezionati e risultano colorati di un giallo acceso, cliccando sull'icona Zoom su 
selezione l'estensione dell'area di mappa permetterà di visualizzare tutti i poligoni relativi alle 
località del comune di Viterbo, utilizzando tutta la finestra grafica. 

 

 

 

I dati associati: selezionare elementi a partire da lla loro posizione 
Supponiamo invece di voler partire da un gruppo di poligoni del nostro vettore, scelti in base alla 
loro posizione geografica, e di voler conoscere le informazioni ad esse associate. La prima ipotesi 
potrebbe essere quella di interrogarli uno ad uno con l'icona Informazioni geometrie oppure 
utilizzare ancora una volta le funzioni di selezione. 

Per far ciò è possibile cliccare sull'icona Seleziona geometrie  e selezionare un gruppo di 
poligoni del vettore in esame disegnando con il mouse un rettangolo che li contiene; per fare questo, 
cliccate con il tasto sinistro per individuare il primo vertice, spostatevi (mantenendo premuto il 
tasto) per disegnare l'area e infine rilasciate il tasto, proprio come si fa per eseguire uno zoom su 
un'area della mappa. 

Le geometrie che ricadono totalmente o parzialmente dentro il riquadro disegnato verranno 
selezionate e si coloreranno di un giallo acceso, tra l'altro è possibile selezionare gruppi di poligoni 
non contigui tenendo premuto il tasto Ctrl  e replicando l'azione di selezione su un'altra zona della 
mappa. 

A questo punto aprendo la tabella associata al vettore e cliccando sul tasto Muovi selezioni in alto 
potremo analizzare il contenuto dei record associati ai poligoni selezionati sulla mappa. 

 



Il materiale è stato prodotto nell'ambito del progetto “Geographic Information Systems - opportunità di integrazione tra natura e tecnologia e nuovo strumento per la 
diffusione della cultura scientifica”, realizzato dal Ministero dell'Istruzione dell'Università e della Ricerca in collaborazione con la Società Geografica Italiana, le 
Università "la Sapienza" e "Tor Vergata" di Roma, l'Associazione degli insegnanti di geografia e MondoGIS. In particolare le lezioni sono state curate da MondoGIS in 
collaborazione con Faunalia, azienda specializzata nell'uso di software GIS free open-source. La licenza del materiale è: http://creativecommons.org/licenses/by-sa/2.5/it/ 

 4/12 

 

 

Personalizzare la mappa: attribuire colori 
Fin ad ora abbiamo caricato dati geografici senza modificare le caratteristiche della loro 
visualizzazione come il colore, le dimensioni o lo stile delle linee o la forma degli elementi 
puntiformi. 

dati vettoriali 
Il modo di operare sui dati raster ed i dati vettoriali è leggermente diverso ma segue in ogni caso la 
stessa logica. Iniziamo ad analizzare come gestire queste caratteristiche sui dati vettoriali iniziando 
dai vettori a geometria lineare. 

Selezioniamo quindi nella legenda il vettore Fiumi_Principali ed apriamo la sua finestra Proprietà 
del Vettoriale cliccando due volte sul nome in legenda o premendo il tasto destro del mouse e 
selezionando la voce Proprietà nella finestra a tendina che si aprirà. 

 

 

 

La finestra Proprietà del Vettoriale è costituita da diverse etichette (dette label) nelle quali 
possiamo trovare numerose opzioni in grado di personalizzare la visualizzazione: 

� linguetta Simbologia: per gestire i colori e lo stile di linee ed elementi puntiformi 
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� linguetta Generale: per modificare il nome in legenda, l'intervallo di scala per la 
visualizzazione e la proiezione associata al dato 

� linguetta Metadati: per visualizzare informazioni più approfondite associate al dato 

� linguetta Etichette: per associare ai diversi elementi del vettore un'etichetta derivante ad 
esempio dal contenuto di un campo della tabella associata 

� linguetta Azioni: per associare al vettore comandi in grado di aprire immagini, documenti, 
pagine web con contenuto diverso a seconda dell'elemento del vettore che si va ad 
interrogare 

In questa lezione cercheremo di analizzare la parte legata alla colorazione e visualizzazione e quindi 
il contenuto della linguetta Generale della finestra delle Proprietà del Vettoriale. 

Possiamo utilizzare questa sezione per modificare lo stile delle linee del nostro vettore (sotto 
sezione Outline style) scegliendo uno stile continuo od uno stile tratteggiato tra quelli disponibili 
nella relativa finestra a tendina. 

Nella sottosezione Outline color è possibile scegliere il colore da applicare alle linee scegliendolo 
nell'apposita tavolozza dei colori che si aprirà cliccando sul riquadro con il colore attualmente 
applicato al vettore. 

Nella sottosezione Outline width  sarà invece possibile modificare lo spessore delle linee 
aumentando il valore numerico nel riquadro relativo. 

Infine sarà possibile impostare un livello di trasparenza agendo sulla barra relativa alla sottosezione 
Trasparenza. 

Il tasto Apply  permetterà di visualizzare le modifiche effettuate senza chiudere la finestra 
Proprietà del Vettoriale, una volta sicuri delle modifiche da apportare si clicca invece il tasto OK . 

Per esercitazione possiamo provare a colorare i fiumi di blu applicando un tratto a linee tratteggiate 
con valore 2 come spessore. 

 

 

 

Passiamo ora a vedere le opzioni in più presenti per i vettori a geometria poligonale aprendo la 
finestra Proprietà del Vettoriale per il vettore Località_abitate. 

Come si vede oltre alle opzioni presenti per gli elementi lineari adesso sono attive anche: 
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- La sottosezione Fill color  per selezionare il colore da applicare al poligono scegliendolo 
nell'apposita tavolozza dei colori che si aprirà cliccando sul riquadro con il colore attualmente 
applicato al vettore. 

- La sottosezione Fill style che permette di applicare all'interno dei poligoni un colore continuo 
(Solid Pattern), una trama tra quelle disponibili nella finestra a tendina, nessun colore e quindi una 
trasparenza completa (No Brush) o un pattern costituito dalla ripetizione di un'immagine scelta 
dall'utente (Texture Pattern). 

L'applicazione della trasparenza è chiaramente in questo caso più apprezzabile che con elementi a 
geometria lineare. 

Per esercitazione proviamo ad applicare un colore rosso scuro ai contorni ed una trama Dense 3 
Pattern di color arancio all'interno dei poligoni del vettore Località_abitate. 

 

 

 

Le proprietà applicabili ad un elemento vettoriale puntiforme permettono invece di applicare ai 
punti una simbologia a scelta tra quelle presenti, una dimensione fissa di tale simbologia o una 
dimensione ed un angolo di rotazione del simbolo sulla base dei valori contenuti in campi della 
tabella associata. 

 

Cartografia tematica in funzione dei dati associati  

dati vettoriali 
Vediamo ora come vestire la nostra cartografia in base ai dati associati ovvero come colorare in 
modo diverso elementi geometrici dello stesso vettore in base al contenuto di un campo della tabella 

Per la vestizione cartografica basata sui dati associati possiamo utilizzare quattro diverse modalità 
di visualizzazione: 

1. Simbolo singolo: la modalità espressa di default che non permette di differenziare le singole 
geometrie. 

2. Valore univoco: differenzia le caratteristiche di visualizzazione dei singoli poligoni in base 
al valore contenuto nel campo prescelto come classificatore. E' la modalità migliore quando 
si scelgono campi categorici (province, classi, tipo di uso del suolo, ecc.). 
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3. Colore continuo: permette di scegliere un campo, assegnare due colori diversi al poligono 
che contiene il valore più basso e il valore più alto per quel campo. In automatico verrà 
costruita una scala di colori tra i due scelti è assegnato ad ogni poligono un colore diverso a 
seconda della sua posizione lungo questa scala che si basa sul valore contenuto nel campo 
prescelto. Tale modalità è idonea per i campi numerici (area, perimetro, numero abitanti, 
ecc.). 

4. Simbolo graduato: permette di scegliere un campo, decidere in quanti intervalli deve essere 
diviso l'intervallo di valori contenuto nel campo stesso ed assegnare ad ogni gruppo e quindi 
ad ogni poligono che vi ricadrà un colore diverso. Anche questa modalità è idonea per i 
ampi numerici. 

 
 

 

 

 

Iniziamo con analizzare la modalità Valore univoco rimuovendo tutti i dati geografici caricati e 
caricando lo strato vettoriale Dati_comuni_Lazio.shp che, attenzione, risulta associato ad un'altra 
proiezione geografica e che quindi non potrà essere sovrapposto in modo automatico agli altri dati 
in nostro possesso. Una volta caricato visualizziamone la tabella per vedere quali sono le 
informazioni associate. 

I campi presenti sono diversi ma, come abbiamo detto, a noi interessa identificare un campo 
categorico quale ad esempio il campo PROVINCIA che contiene i nomi delle 5 province del Lazio. 

Per colorare i diversi comuni in base al contenuto di tale campo e quindi della provincia di 
appartenenza si apre la finestra Proprietà del vettoriale e nella sezione Generale si seleziona dalla 
finestra a tendina della sottosezione Tipo di Legenda la modalità Valore univoco. 

A questo punto la finestra muterà aspetto e permetterà di selezionare un campo della tabella 
associata da usare per differenziare i colori e le altre caratteristiche di visualizzazione dei diversi 
poligoni. Si seleziona quindi il campo PROVINCIA dalla sottosezione Campo di classificazione e 
si clicca sul tasto Classify. Nel riquadro sottostante appariranno tutti i possibili valori presenti nel 
campo selezionato (i nomi delle province) e cliccando su ognuno di questi vedremo a sinistra le 
caratteristiche di vestizione ad esso assegnate. 
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E chiaramente possibile assegnare ad ognuna di queste categorie una rappresentazione particolare 
sia per quanto riguarda lo stile ed il colore della linea di contorno e il pattern ed il colore dell'area 
del poligono. Una volta decise queste caratteristiche si clicca sul tasto OK  e si visualizza il 
risultato. Nella legenda si possono osservare le diverse categorie contenute nel campo prescelto ed i 
colori ad esse associati. 

 

 

 

Vediamo ora come agire con la modalità Colore continuo ed andiamo quindi ad identificare nella 
tabella associata un campo idoneo a questa modalità, ad esempio il campo ANZIANI_PE che 
contiene il numero di anziani per ogni 100 abitanti in ogni comune. 

Per colorare i diversi comuni in base al contenuto di tale campo si apre la finestra Proprietà del 
vettoriale e nella sezione Generale si seleziona dalla finestra a tendina della sottosezione Tipo di 
Legenda la modalità Colore continuo. 

Anche questa volta la finestra muterà aspetto e permetterà di selezionare un campo della tabella 
associata da usare per differenziare i colori dei diversi poligoni. Si seleziona quindi il campo 
ANZIANI_PE nella sottosezione Campo di classificazione, si seleziona un colore per il valore più 
piccolo contenuto nel campo, per esempio giallo chiaro, ed un colore per il valore massimo, per 
esempio rosso scuro.  
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Si clicca quindi il tasto OK  per visualizzare il risultato: i comuni con maggior numero di anziani 
per abitante saranno colorati di rosso scuro e gli altri con tonalità via via più vicine al giallo chiaro 
fino al comune con minor numero di anziani ogni 100 abitanti. Nella legenda si possono osservare il 
valore minimo, il massimo ed i colori ad esso assegnati. 

 

 

 

Vediamo infine come lavorare con la modalità Simbolo graduato ed andiamo quindi ad identificare 
nella tabella associata un campo idoneo a questa modalità di vestizione, ad esempio il campo 
OCCUPATI_2 che contiene il numero di occupati in un determinato settore per ogni comune. 

Per colorare i diversi comuni in base al contenuto di tale campo si apre la finestra Proprietà del 
vettoriale e nella sezione Generale si seleziona dalla finestra a tendina della sottosezione Tipo di 
Legenda la modalità Simbolo graduato. 

Anche questa volta la finestra muterà aspetto e permetterà di selezionare un campo della tabella 
associata da usare per differenziare i colori dei diversi poligoni. Si seleziona quindi il campo 
OCCUPATI_2 nella sottosezione Campo di classificazione, si lascia invariata la modalità Equal 
interval nella sottosezione Modalità , si definisce il numero di classi in 5 nella sottosezione 
Numero di classi ed infine si preme il tasto Classify. 
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Come vediamo nel riquadro bianco compariranno 5 intervalli di valori ognuno rappresentante una 
classe e per ognuno di essi saranno preimpostate le caratteristiche di vestizione visibili nella 
sottosezione Style options cliccando su ogni intervallo. I colori assegnati seguono una scala 
predefinita ma tale scala può essere modificata modificando le proprietà associate ad ogni classe. 

Cliccando sul tasto OK  sarà possibile vedere il risultato nell'area di mappa; ogni comune sarà 
colorato in base alla classe di appartenenza rispetto al numero di occupati presenti in ogni comune. 
Nella legenda si possono osservare gli intervalli delle 5 classi ed i colori ad esse associati. 

 

 

 

dati raster 
A questo punto analizziamo come impostare le caratteristiche di visualizzazione di un raster in 
modo dipendente dal valore delle sue celle; per far questo rimuoviamo lo strato Dati_comuni_Lazio 
e carichiamo il raster DEM w001001, che rappresenta l'altitudine. 

Aprendo la finestra Proprietà raster con lo stesso metodo con cui si apre la corrispondente finestra 
dei dati vettoriali vedremo che questa avrà linguetta leggermente diverse. 

� linguetta Simbologia: per gestire le scale di colori applicate al raster e la trasparenza 
generica dello stesso. 

� linguetta Transparent Pixel: per impostare quali valori del raster debbano risultare 
completamente trasparenti 
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� linguetta Generale: per modificare il nome in legenda, l'intervallo di scala per la 
visualizzazione e la proiezione associata al dato 

� linguetta Metadati: per visualizzare informazioni più approfondite associate al dato 

� linguetta Piramidi : per gestire la risoluzione del raster in modo diverso a seconda della 
scala di visualizzazione e velocizzare così il suo caricamento 

� linguetta Istogramma: per effettuare istogrammi relativi alla distribuzione dei valori delle 
celle del aster 

�  

 

 

Anche in questo caso porremo l'attenzione sulle caratteristiche di vestizione del nostro raster. 

Innanzitutto vogliamo rendere trasparente lo sfondo nero del raster w001001 che, come vi 
ricorderete dalla prima lezione, a seguito di un'interrogazione fornisce valore 0 e che rappresenta ad 
est il mare e nelle altre direzioni il territorio di altre province. 

Sceglieremo quindi la linguetta Transparent Pixels e imposteremo il valore 0 nel riquadro No data 
value in alto a destra della finestra e cliccheremo quindi sul tasto Apply ; lo sfondo nero risulterà 
ora completamente trasparente. 

Ci sposteremo ora sulla linguetta Generale e nella sezione Mappa colore sceglieremo l'opzione 
Pseudo colore nell'apposita finestra a tendina e cliccheremo nuovamente sul tasto Apply  per 
visualizzare la nuova colorazione. Cliccheremo infine sul tasto OK  per accettare le modifiche. 
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Avremo così visualizzato solamente la zona relativa alle terre emerse della regione ed avremo 
applicato ad essa una nuova scala di colore in cui ogni cella associata allo stesso valore risulterà 
colorata nello stesso modo. 

 

 

 

Il caricamento di differenti dati può essere sperimentato a piacimento, assegnando i colori più 
appropriati per i vari strati (ad esempio fiumi in azzurro, comuni colorati e parzialmente trasparenti, 
e elevazione in toni di grigio). 



Il materiale è stato prodotto nell'ambito del progetto “Geographic Information Systems - opportunità di integrazione tra natura e tecnologia e nuovo strumento per la 
diffusione della cultura scientifica”, realizzato dal Ministero dell'Istruzione dell'Università e della Ricerca in collaborazione con la Società Geografica Italiana, le 
Università "la Sapienza" e "Tor Vergata" di Roma, l'Associazione degli insegnanti di geografia e MondoGIS. In particolare le lezioni sono state curate da MondoGIS in 
collaborazione con Faunalia, azienda specializzata nell'uso di software GIS free open-source. La licenza del materiale è: http://creativecommons.org/licenses/by-sa/2.5/it/ 

  1/9 

Il materiale è stato prodotto nell'ambito del progetto “Geographic Information Systems - 
opportunità di integrazione tra natura e tecnologia e nuovo strumento per la diffusione della 
cultura scientifica”, realizzato dal Ministero dell'Istruzione dell'Università e della Ricerca in 
collaborazione con la Società Geografica Italiana, le Università "la Sapienza" e "Tor Vergata" di 
Roma, l'Associazione degli insegnanti di geografia e MondoGIS. In particolare le lezioni sono state 
curate da MondoGIS in collaborazione con Faunalia, azienda specializzata nell'uso di software GIS 
free open-source. La licenza del materiale è: http://creativecommons.org/licenses/by-sa/2.5/it/ 

 

Quarta lezione: Aggiungere le proprie informazioni 

Punti, linee, poligoni; cos'è un GPS, come si usa, come si caricano i dati 
 

Aggiungere le proprie informazioni: punti, linee, poligoni 
Fino ad ora abbiamo visto come caricare ed utilizzare dati geografici già presenti, vediamo ora 
invece come costruire e modificare nuovi dati geografici vettoriali. 

Innanzitutto occorre specificare che in un file in formato shape non possono coesistere tipi di 
geometrie diverse e che quindi un dato vettoriale conterrà solo punti, oppure linee oppure poligoni, 
ma non una combinazione dei tre. 

Le icone dedicate a questa funzionalità, conosciuta con il nome di digitalizzazione (in inglese 
editing), sono quelle riportate in figura. 

 

Ognuna di esse ha una funzione diversa che sarà di seguito analizzata:  

 

�  Avvio e termine della sezione di modifica di un dato vettoriale 

�  Aggiungere elemento puntiforme 

�  Aggiungere elemento lineare 

�  Aggiungere elemento poligonale 

�  Inserire un buco in un poligono già esistente 
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�  Aggiungere un elemento collegato ad uno già esistente 

�  Spostare un elemento selezionato 

�  Tagliare elementi selezionati 

�  Cancellare gli elementi selezionati 

�  Aggiungere vertici ad un elemento 

�  Cancellare vertici ad un elemento 

�  Muovere vertici di un elemento 

�  Tagliare elementi selezionati 

�  Copiare elementi selezionati 

�  Incollare elementi tagliati o copiati 

 

Prima di iniziare questa esercitazione è necessario fissare il raggio di ricerca per il nostro puntatore  
ed il livello di “snapping” o di tolleranza. 

Il primo è il raggio d'azione del puntatore che permette di selezionare un oggetto od un vertice 
senza dover cliccare su di esso in modo estremamente preciso. 

Il secondo è quella distanza al di sotto della quale due punti o due vertici che andiamo a disegnare si 
uniscono in modo automatico. Questo permette ad esempio di unire in modo più facile due linee 
disegnate in due momenti diversi oppure di disegnare con più facilità due poligoni adiacenti. 

Entrambi dipendono dalla scala di rappresentazione al video durante la sessione di modifica; tanto 
più è grande la scala tanto più elevati dovranno essere tali valori e viceversa. 

Innanzitutto occorre caricare un dato da utilizzare come base di riferimento per identificare dove 
posizionare gli elementi che stiamo creando. Carichiamo quindi lo strato raster Roma_P.tif, 
applichiamo le caratteristiche di visualizzazione viste nella precedente lezione e impostiamo la scala 
al valore 1:50.000. 

Per impostare il raggio di ricerca è sufficiente attivare la finestra Opzioni QGIS tramite il percorso 
Impostazioni → Opzioni... e scegliendo la etichetta Digitalizzazione. Nella sottosezione 
Snapping  imposteremo il valore per Search radius for vertex edits (in layer units) con il valore 
100. Ciò vorrà dire che quando ad esempio cercherò di muovere un vertice per selezionarlo sarà 
sufficiente andare ad una distanza inferiore ai 100 metri (sulla mappa) per poter agire su di esso. 
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Una volta avviata la digitalizzazione di un vettore occorrerà invece impostare per esso il livello di 
snapping adatto per questa scala attivando la finestra Proprietà della Proiezione tramite il percorso 
Impostazioni → Proprietà del progetto e scegliendo la etichetta Generale. Nella sottosezione 
Digitalizzazione visteremo le opzioni presenti e cliccando sul tasto Snapping Options 
imposteremo per lo strato in fase di modifica la Modalità  To vertex and segment e la Tolerance con 
il valore 100.  

Tutto ciò significa semplicemente che quando digito tale vettore voglio evitare sovrapposizione tra 
poligoni od incroci di linee e che voglio che elementi come vertici e linee ad una distanza inferiore 
a 100 metri si uniscano in modo automatico. 

Elementi puntiformi 
Iniziamo con qualcosa di semplice, ad esempio la digitalizzazione di un elemento puntiforme che 
rappresenti la posizione di alberi secolari sul territorio della regione. 

Possiamo creare il nuovo strato vettoriale cliccando sull'icona Nuovo layer vettoriale  o 
scegliamo il percorso Layer → Nuovo layer vettoriale dalla Barra del i menù. In questo modo si 
genererà un nuovo file, che conterrà tutti gli elementi puntiformi che andremo a digitalizzare. 

Si aprirà a questo punto una finestra di inizializzazione dove dovremo scegliere il Tipo di geometria 
(punto) e dove dovremo determinare il nome e il tipo dei contenuti dei campi della tabella che 
assoceremo al nostro vettore. Per semplicità inseriremo solamente il campo età con contenuto di 
numeri interi (Integer) ma è chiaramente possibile inserire più campi scegliendo come tipo di 
contenuto numeri interi (Integer), numeri reali (Real) o caratteri (String). Una volta completata la 
tabella si preme il tasto OK  e si va a scegliere nella nuova finestra il nome del nuovo shapefiles e la 
cartella in cui salvarlo. 

 

 

A questo punto verrà caricato nella legenda il nome del nuovo file associato ad una piccola icona 
che ne caratterizza la geometria (punti) ma chiaramente essendo esso vuoto niente comparirà 
nell'area di mappa. 
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A questo punto imposteremo il livello di snapping per questo strato al valore di 100 metri come 

prima illustrato ed avvieremo la digitalizzazione premendo l'icona Toggle editing  o cliccando 
con il tasto destro del mouse sul nome del vettore e scegliendo la voce Toggle editing nel menù a 
tendina. 

Le icone del menù di digitalizzazione prima disattivate si attiveranno passando dalla modalità in 
grigio a quella a colori. Si attiveranno chiaramente solo quelle utilizzabili nella modifica di 
geometrie puntiformi. 

Adesso clicchiamo sull'icona Inserisci punto  e si disegnerà il primo elemento facendo un 
unico click con il tasto sinistro del mouse su un punto qualsiasi della mappa, si aprirà la finestra 
degli attributi in cui inserire i valori relativi a quel punto per i campi inseriti nella tabella. Una volta 
inserito il dato si premerà il tasto OK  nella finestra ed il punto comparirà dove avevamo cliccato. 
Ripetiamo l'operazione fino ad avere una decina di punti disegnati sulla mappa. 

Supponiamo ora di esserci accorti di aver posizionato in modo non corretto un albero secolare e di 
voler spostare il punto relativo. Si seleziona il punto in questione utilizzando l'icona Seleziona 

geometrie  e, dopo aver cliccato sull'icona Move Feature  si clicca con il tasto sinistro 
del mouse il punto selezionato e tendendo sempre premuto il tasto si trascina il punto nella nuova 
posizione. Al rilascio del tasto il punto verrà applicato alla nuova posizione. 

Supponiamo invece di essersi accorti di aver posizionato uno o più punti in più e di volerli 
eliminare: si seleziona il punto/i in questione utilizzando sempre l'icona Seleziona geometrie e si 

clicca sull'icona Elimina selezione  per eliminare i punti selezionati. 

Una volta terminata l'operazione di modifica si disattiva tale funzionalità cliccando nuovamente 

sull'icona Toggle editing , la finestra che si aprirà ci chiederà se si voglia o meno salvare le 
modifiche, premendo Save avremo creato il nostro dato vettoriale che potrà essere gestito in modo 
identico agli altri elementi puntiformi. 

Geometrie lineari 
Supponiamo ora di voler invece creare una serie di linee che rappresentino corsi d'acqua. Creiamo il 
nuovo file con le stesse modalità viste prima ma scegliendo come geometrie Linea e come campi 
della tabella: Nome (String) e Lunghezza (Real). 

Impostiamo il livello di snapping per questo nuovo strato sempre con valore 100 ed avviamo la 
digitalizzazione cliccando sull'icona Toggle editing ed osserviamo le icone che si attivano nel menù 
di modifica. 

Iniziamo a modificare il primo corso d'acqua selezionando l'icona Inserisci linea  e 
cominciamo a digitalizzare la linea rappresentante il nostro corso d'acqua cliccando sulla mappa con 
il tasto sinistro del mouse per definire la posizione dei vertici dei singoli segmenti contigui che 
costituiscono la linea.  
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Una volta terminato di disegnare il primo corso d'acqua, si clicca con il tasto destro del mouse e si 
interrompe la sua digitalizzazione; nella finestra che si aprirà dovranno essere inseriti i valori dei 
campi prima creati. Come vediamo sullo schermo la prima linea è stata disegnata ed i vertici tra un 
segmento ed un altro sono rappresentati da piccoli cerchi semitrasparenti. 

Se volessimo spostare l'intera linea utilizzeremo l'icona Move Feature senza dover prima 
selezionare la linea ma semplicemente cliccando con il tasto sinistro del mouse su di essa e 
trascinandola tenendo premuto il tasto. 

Nel caso volessimo affinare la posizione dei singoli vertici od aumentarne o ridurre il loro numero 
potremo utilizzare la serie di icone dedicate ai vertici nel menù di digitalizzazione.  

Se vogliamo spostare un vertice utilizzeremo l'icona Sposta vertice ; dopo aver cliccato su 
essa cliccheremo su un vertice con il tasto sinistro e lo trascineremo fino alla nuova posizione 
tenendo premuto il tasto. 

Se vogliamo aggiungere un nuovo vertice e contemporaneamente definirne una nuova posizione 

cliccheremo sull'icona Aggiungi vertice  e cliccando con il tasto sinistro lungo un segmento di 
una linea aggiungeremo un nuovo vertice alla linea stessa, se quando clicchiamo per inserire il 
nuovo vertice non rilasciamo il tasto sinistro, spostandoci potremo definire subito la posizione del 
nuovo vertice. 

Se infine vogliamo eliminare un vertice già esistente si attiva l'icona Elimina vertice  e si 
clicca poi sul vertice da eliminare con il tasto sinistro, il vertice scomparirà e la linea tra i vertici 
contigui a quello eliminato tornerà ad unirsi in modo retto. 

Supponiamo invece di essersi accorti di aver creato alcuni elementi lineari errati o in più e di volerli 
eliminare: si seleziona la linea o le linee in questione utilizzando ancora l'icona Seleziona 

geometrie e si clicca sull'icona Elimina selezione  per eliminare gli elementi selezionati. 

Nel caso in cui volessimo proseguire un tratto di linea aggiungendo nuovi segmenti in contiguità 
con quelli esistenti potremo sfruttare il livello di tolleranza che abbiamo impostato ed utilizzare 
chiaramente l'icona Aggiungi linea. E' possibile andare a proseguire una linea già esistente 
iniziando la nuova digitalizzazione il più vicino possibile ad uno dei vertici esterni alla linea o 
creare un ramificazione della stessa iniziando la modifica vicino ad uno dei vertici interni. 

Come si potrà vedere lo snapping impostato permette di far andare a coincidere automaticamente il 
primo vertice modificato con quello scelto sulla linea già esistente e quindi ottenere come risultato 
una unica linea. 

La stessa funzionalità permette di spostare un vertice esistente e di farlo coincidere con un altro 
ponendo i due elementi in contiguità. 

Una volta terminata l'operazione di modifica, si disattiva tale funzionalità cliccando nuovamente 

sull'icona Toggle editing , la finestra che si aprirà ci chiederà se si voglia o meno salvare le 
modifiche, premendo Save avremo creato il nostro dato vettoriale che potrà essere gestito in modo 
identico agli altri elementi lineari visti prima. 
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Geometrie poligonali 
Poniamo adesso di voler digitalizzare una carta poligonale che rappresenti i diversi uso del suolo 
(bosco, coltivazione, laghi, zone edificate...) presenti in un territorio. 

Creiamo il nuovo vettore con le stesse modalità viste prima ma scegliendo come geometria 
Poligono e creando una tabella che contenga informazioni sul codice che assegniamo ad ogni 
diverso uso del suolo (codice, integer) ed una sua descrizione (desc, string). 

Impostiamo il livello di tolleranza per questo nuovo strato sempre con valore 100, avviamo la 
digitalizzazione cliccando sull'icona Toggle editing ed osserviamo le icone che si attivano nel menù 
di modifica. 

Iniziamo a modificare il primo poligono dell'uso del suolo selezionando l'icona Inserisci linea 

 e cominciamo a digitalizzare l'area del nostro primo poligono che poniamo rappresenti un'area 
boscata cliccando sulla mappa con il tasto sinistro del mouse per definire la posizione dei vertici del 
poligono che in automatico andrà a formarsi. Una volta terminato di disegnare il primo poligono si 
clicca con il tasto destro del mouse sull'ultimo vertice e si interrompe la sua digitalizzazione; nella 
finestra che si aprirà dovranno essere inseriti i valori dei campi prima creati. Anche in questo caso i 
vertici tra un lato ed un altro del poligono sono rappresentati da piccoli cerchi semitrasparenti.  

Se volessimo spostare l'intera poligono utilizzeremo l'icona Move Feature senza dover prima 
selezionare il poligono ma semplicemente cliccando con il tasto sinistro del mouse su di esso e 
trascinandolo tenendo premuto il tasto. 

Nel caso volessimo affinare la posizione dei singoli vertici od aumentarne o ridurre il loro numero 
anche in questo caso potremo utilizzare la serie di icone dedicate ai vertici nel menù di 
digitalizzazione.  

Se vogliamo spostare un vertice utilizzeremo l'icona Sposta vertice ; dopo aver cliccato su 
essa cliccheremo su un vertice con il tasto sinistro e lo trascineremo fino alla nuova posizione 
tenendo premuto il tasto. 

Se vogliamo aggiungere un nuovo vertice e contemporaneamente definirne una nuova posizione 

cliccheremo sull'icona Aggiungi vertice  e cliccando con il tasto sinistro lungo un lato di un 
poligono aggiungeremo un nuovo vertice al lato stesso, se quando clicchiamo per inserire il nuovo 
vertice non rilasciamo il tasto sinistro, spostandoci potremo definire subito la posizione del nuovo 
vertice. 

Se infine vogliamo eliminare un vertice già esistente si attiva l'icona Elimina vertice  e si 
clicca poi sul vertice da eliminare con il tasto sinistro, il vertice scomparirà e il lato tra i vertici 
contigui a quello eliminato tornerà ad unirsi in modo retto. In questo modo potremo manipolare e 
rendere più precisa la forma del poligono digitalizzato. 

Supponiamo invece di essersi accorti di aver creato alcuni elementi poligonali errati e di volerli 
eliminare: si seleziona il poligono in questione utilizzando ancora l'icona Seleziona geometrie e si 

clicca sull'icona Elimina selezione  per eliminare l'elemento selezionato. 
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Poniamo adesso di voler creare un piccolo buco (ad esempio una radura nel bosco) all'interno del 

poligono digitalizzato; clicchiamo sull'icona Add a ring  ed utilizzando la stessa tecnica usata 
per creare un poligono, disegniamo un buco all'interno di un poligono già esistente. 

Come abbiamo visto ogni volta che inseriamo un nuovo poligono QGIS richiede di inserire le 
informazioni del record ad esso associato; nel caso in cui volessimo creare un oggetto composto da 
più poligoni che si comportino come un unico elemento e che quindi siano anche associati ad un 
unico record si può creare il cosiddetto 'multipoligono'. 

Si va quindi a selezionare, con l'icona Seleziona geometrie, un poligono già esistente a cui si vuole 

associare un altro elemento, si clicca poi sull'icona Add Island  e si inizia la digitalizzazione 
di un nuovo poligono. Una volta conclusa questa operazione si potrà vedere che interrogando l'uno 
o l'altro poligono otterremo la stessa informazione associata e che selezionando uno si va a 
selezionare automaticamente anche l'altro elemento. 

Nel caso in cui volessimo disegnare un poligono confinante con uno o più già esistenti, evitando di 
creare buchi od intersezioni lungo il confine tra i due, potremo sfruttare il livello di tolleranza che 
abbiamo impostato ed utilizzare direttamente l'icona Aggiungi poligono per creare il nuovo 
elemento. Dovremo iniziare la digitalizzazione il più vicino possibile ad uno dei vertici od ad un 
lato di un poligono già esistente in modo che il livello di tolleranza faccia sì che vertici o lati posti a 
distanza inferiore del valore impostato vadano a coincidere automaticamente senza lasciare spazi o 
creare zone di sovrapposizione tra i due poligoni. 

La stessa funzionalità permette di spostare i vertici di un poligono esistente e di farne coincidere il 
lato con quello di un altro poligono ponendo i due elementi in contiguità. 

Una volta terminata l'operazione di modifica si disattiva tale funzionalità cliccando nuovamente 

sull'icona Toggle editing , la finestra che si aprirà ci chiederà se si voglia o meno salvare le 
modifiche, premendo Save avremo creato il nostro dato vettoriale che potrà essere gestito in modo 
identico agli altri elementi poligonali visti prima. 

 

Punti GPS 
GPS è l'acronimo di Global Positioning System, ovvero Sistema Globale di Rilevamento della 
Posizione. Questa tecnologia è un sistema mondiale di navigazione in grado di individuare le 
proprie coordinate geografiche in qualunque punto della superficie terrestre grazie ai segnali inviati 
ad esso da una serie di satelliti orbitanti intorno alla terra. 

Il sistema GPS sta velocemente entrando sia nel linguaggio che nella vita di molti ed anche se si 
basa su principi abbastanza semplici fa uso di tecnologie estremamente avanzate e in breve fornisce 
in tempo reale la posizione esatta del ricevitore, oltre alla direzione e alla velocità di marcia. Ad 
esempio, i navigatori satellitari basano il loro funzionamento su un GPS presente al loro interno, 
così come i GPS personali utilizzati per il trekking e per la navigazione in mare. Molti cellulari di 
ultima generazione hanno al loro interno un GPS, che consente di trovare percorsi e punti di 
interesse direttamente dal proprio telefono. 
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Poniamo di avere a disposizione un GPS e di uscire fuori dalla scuola per raccogliere alcuni punti 
(detti waypoints) relativi alla nostra posizione e quindi a quella della scuola. Una volta rientrati si 
carica il progetto salvato nelle precedenti lezioni, si collega il GPS al computer tramite l'apposito 
cavetto USB e si avvia il plugin di QGIS che permette di leggere e proiettare sulla mappa il dato 
registrato sul GPS stesso. 

Il plugin viene lanciato tramite l'icona Strumenti GPS  oppure tramite il percorso Plugins → 
GPS → Strumenti GPS dalla Barra dei menù. Si aprirà quindi l'interfaccia Strumenti GPS in cui 
dovrà essere selezionata l'etichetta Download dal GPS. 

 

 

 

Tale interfaccia permette di scaricare punti salvati nel GPS e di salvarli nel formato testo .gpx in una 
cartella a scelta dell'utente in modo che possano essere ricaricati tramite tale interfaccia in qualsiasi 
momento vogliamo. Scegliamo quindi la porta a cui è collegato il GPS tramite la specifica Porta, 
scegliamo dove e con che nome salvare il file .gpx tramite la specifica File di output e che nome 
dare allo strato caricato in mappa Nome layer. Poi premiamo il tasto OK . 

Se tutto è stato eseguito correttamente il nome dello strato dovrebbe apparire in legenda ma i punti 
non dovrebbero essere visibili ed anche cliccando sul taso Vista massima tale punti dovrebbero 
apparire lontanissimi dalla loro corretta posizione. Questo per il semplice motivo che i nostri punti 
scaricati dal GPS sono scaricati in coordinate latitudine-longitudine e sistema di proiezione WGS 
84 mentre i nostri dati cartografici sono in coordinate metriche e sistema di proiezione UTM 
EDL79 fuso 32N. Occorrerà quindi riproiettare tutto in un unico sistema di proiezione per 
visualizzare correttamente i dati. 

Per far questo si apre l'interfaccia Proprietà della proiezione seguendo il percorso Impostazioni 
→ Proprietà del progetto e si attiva la etichetta Proiezione. Qui abbiamo una lista di tutte le 
proiezioni disponibili e gestite da QGIS ed occorre trovare nella lista la proiezione UTM EDL79 
fuso 32N in modo da riproiettare anche i dati provenienti da GPS in questa proiezione. 
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Per farlo è sufficiente scrivere il codice PostGIS della proiezione (2077) nel riquadro bianco della 
sottosezione Cerca in fondo alla finestra e premere il tasto Trova, in automatico sarà selezionata la 
riga EL79/UTM zone 32N tra i Sistemi di riferimento Spaziale, si spunterà l'opzione Abilita la 
proiezione al volo e si premerà il tasto OK . 

Premendo sull'icona Vista massima visualizzeremo così i nostri dati cartografici della regione 
Lazio ed i punti scaricati da GPS nella loro posizione corretta, risulta chiaro che se la vostra scuola 
si trova nel Lazio i punti cadranno all'interno dei dati cartografici caricati altrimenti andranno a 
cadere in un'altra zona d'Italia. 

Poniamo di voler caricare i dati precedentemente scaricati o che qualcuno ci abbia fornito in 
formato gpx. Ricarichiamo il nostro progetto ed attiviamo ancora una volta il plugin Strumenti 
GPS scegliendo stavolta la etichetta Carica file GPX. 

 

 

 

A questo punto clicchiamo sul tasto Browse per cercare il file .gpx prima creato oppure, in 
mancanza di esso, il file GPS_Roma.gpx presente nella cartella dei dati di esempio, lasciamo 
spuntato solo la voce Waypoints nella sottosezione Tipo di dati  e premiamo il tasto OK . 

Clicchiamo nuovamente sull'icona Vista massima per visualizzare l'attuale posizione dei punti 
rispetto alla nostra cartografia e ripetiamo l'operazione di riproiezione come visto poco fa. Se il 
tutto è eseguito correttamente i dati scaricati da GPS andranno a posizionarsi nella precedente 
corretta posizione mentre i punti relativi al file GPS_Roma.gpx andranno a posizionarsi nel comune 
di Roma. 

Le caratteristiche di visualizzazione dei punti GPS possono essere cambiati tramite la finestra 
Proprietà del vettoriale come per qualsiasi altro vettore di punti. 
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Quinta lezione: Stampare una mappa e salvarla in vari formati 

Utilizzare il prodotto per inserirlo in relazioni, come base di disegni 
 

In questa lezione vedremo come creare una mappa corredata da vari elementi come titoli, scala, 
legende e quant'altro da salvare ed utilizzare come elemento da inserire in una relazione o come 
base per un disegno. 

Compositore di mappa 
Prima di tutto carichiamo il nostro progetto, aggiungiamo strati a piacere e definiamone la 
vestizione, poi facciamo uno zoom sulla zona di nostro interesse e di cui vogliamo creare la 
cartografia. 

A questo punto clicchiamo sull'icona 'Stampa'  oppure attiviamo il percorso File -> Stampa 
dalla Barra dei menù. Si aprirà la finestra QGIS – compositore di mappe che ingrandiremo a 
tutto schermo e che utilizzeremo per creare la nostra cartografia. 
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Attenzione: se sul lato destro non vedremo nessun menù o se le proporzione tra tale menù ed il 
foglio di stampa sono sproporzionate clicchiamo con il tasto sinistro sulla serie di puntini grigi 
disposti verticalmente posti sulla destra della finestra o tra il menù e il foglio di stampa e 
trasciniamoli in modo da settare le giuste dimensioni degli elementi come in figura. 

Il menù di destra è composto da due etichette: una denominata Generale che contiene informazioni 
generali sul formato, dimensione e disposizione del foglio di mappa e della sua risoluzione ed una, 
denominata Oggetto che cambia a secondo dell'oggetto selezionato sul foglio di mappa (cartografia, 
etichetta, legenda, ecc.) permettendone di modificarne le caratteristiche. 

A questo punto nel menù a destra, etichetta Generale, sottosezione Carta, settiamo la dimensione 
del foglio di stampa dal menù a tendina della voce Dimensione, ad esempio scegliamo A4 
(210x297 mm), ed iniziamo quindi ad inserire i nostri elementi nel foglio di stampa. 

Clicchiamo sull'icona 'Aggiungi mappa'  sul menù ad icone in alto e tenendo premuto il tasto 
sinistro del mouse disegniamo un box sul foglio di mappa al cui interno apparirà la cartografia 
presente sull'area di mappa principale di QGIS. La posizione di tale box è modificabile cliccando su 
di esso con il tasto sinistro del mouse e trascinandola nella nuova posizione, mentre la dimensione è 
modificabile tramite le voci Larghezza e Lunghezza contenute nella menù Oggetto. 

 

 

 

Possiamo decidere se ci interessa che nella nostra stampa appaia una zona particolare della nostra 
cartografia oppure se ci interessa definire più un scala a cui settare la stampa. 

Nel primo caso si sposta e si effettuano zoom sulla mappa principale di QGIS finché non abbiamo 
individuato la nostra zona di interesse, poi si torna sulla finestra QGIS – compositore di mappe e 
si clicca sul tasto Definisci estensione sul menù Oggetto per visualizzare i cambiamenti nel foglio 
di stampa. 
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Nel secondo caso si individua il centro dell'area di interesse sulla mappa principale di QGIS e poi si 
setta prima l'opzione Scala (calcola estensione) alla voce Definisci e poi il valore di scala alla voce 
Scale (es. 25.000), opzioni entrambe contenute nella etichetta Oggetto del menù di destra della 
finestra QGIS – compositore di mappe. Per verificare la nuova scala di visualizzazione si clicca 
sul tasto Definisci estensione posto subito sotto. 
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Si possono a questo punto inserire elementi decorativi quali ad esempio un titolo tramite l'icona 

'Aggiungi nuova etichetta'  nel menù ad icone in alto. Cliccando su di essa apparirà un'etichetta  
“Quantum GIS” che potrà essere posizionata dove si desidera ed il cui contenuto potrà essere 
modificato dal box bianco della etichetta Oggetto del menù di destra. Tale menù permetterà inoltre 
di cambiare dimensione e stile del carattere del titolo, tasto Carattere, e di inserire una cornice 
intorno ad esso, opzione Box. 

 

 

 

 

Altro elemento decorativo è la legenda che permette di riconoscere nella mappa in preparazione gli 
strati inseriti tramite le loro caratteristiche di vestizione. Per inserirla si clicca sull'icona 'Aggiungi 

nuova legenda vettoriale'  e si posiziona la legenda che appare dove si desidera cliccando il 
tasto sinistro del mouse. Il nuovo menù relativo a tale oggetto permette di definire il titolo della 
legenda, opzione Titolo , di gestire dimensione e stile del carattere, tasto Carattere, di inserire una 
cornice intorno ad esso, opzione Box e di decidere quali strati inserire in legenda e quali no 
eliminando la spunta al nome nel box sottostante. 
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Il nome degli strati che compare in legenda viene preso direttamente dal nome dello strato che 
compare nella legenda della finestra principale di QGIS, è utile ricordare che tale nome è 
personalizzabile andandolo a modificare, per ogni strato, alla voce Nome visualizzato della 
etichetta Generale della finestra Proprietà del vettoriale e cliccando poi sull'icona 'Aggiorna la 
vista' nel menù ad icona della finestra del compositore di mappe. 

 

Infine è possibile inserire una barra di scala cliccando sull'icona 'Aggiungi nuova barra di scala' 

 dal menù ad icone in alto (la barra di scala è un elemento, di solito presente nelle carte 
geografiche, che permette di valutare quale distanza reale sul terreno corrisponda ad una distanza 
visualizzata sulla mappa); anche in questo casa la barra di scala può essere posizionata  cliccando il 
tasto sinistro del mouse sul foglio di mappa. Tramite il menù Oggetto sulla destra della finestra, è 
possibile regolare la lunghezza dei singoli segmenti della barra di scala, tramite l'opzione 
Dimensione segmento, il numero dei segmenti che costituiscono la barra, tramite l'opzione 
Numero di segmenti, dimensione e stile del carattere, tasto Carattere, e lo spessore della barra 
tramite l'opzione Spessore della linea. 

Inizialmente queste misure saranno espresse in metri lineari, se volessimo avere informazioni sulla 
barra in chilometri allora dovremo innanzitutto cambiare il carattere “m” (metri) in “km” 
(chilometri) nell'opzione Unità etichetta e poi cambiare il valore 1 nell'opzione Unità mappa per 
unità di barra di scala con il valore 1000; ciò vuol dire che l'unità di misura della barra di scala 
sono 1000 metri ovvero 1 chilometro. 

Fare attenzione al fatto che la Dimensione del segmento continua ad essere espressi in metri lineari 
e non in chilometri. 
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A questo punto avremo terminato la composizione della nostra mappa ma ricordiamoci che abbiamo 
ancora la possibilità di cambiare le caratteristiche dei nostri elementi, la posizione e l'estensione 
della mappa visualizzata nel foglio di mappa, le caratteristiche di vestizione degli strati visualizzati 
e perché no aggiungerne di nuovi sempre ricordandosi di cliccare sull'icona 'Aggiorna la vista' dopo 
aver effettuato le nostre modifiche. E' chiaramente possibile anche eliminare un elemento 
decorativo inserito selezionandolo con il tasto sinistro del mouse e premendo il tasto Canc sulla 
tastiera. 

Una volta che siamo soddisfatti del nostro risultato è possibile stampare direttamente il nostro 

lavoro su stampante o creare un file pdf del risultato tramite l'icona 'Stampa'  oppure è 
possibile salvare tale lavoro in formato immagine, scegliendo tra i vari risultati disponibili, 

cliccando sull'icona 'Esporta come immagine'  e scegliendo: formato, nome e cartella dove 
salvare l'immagine. 

Tale immagine potrà essere inserita in relazioni, presentazioni e quant'altro come una normale 
immagine oppure aperta con un semplice software di manipolazione d'immagine e modificata. 
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Sesta lezione: Elaborare i dati geografici 

Tecniche di analisi, selezioni geografiche, sovrapposizioni, generazione di 
aree di rispetto. 

 

Elaborare i dati geografici: tecniche di analisi 
Il GIS consente di mettere in relazione tra loro dati diversi, sulla base del loro comune riferimento 
geografico in modo da creare nuove informazioni a partire dai dati esistenti. 

I GIS presentano normalmente delle funzionalità di analisi spaziale ovvero di trasformazione ed 
elaborazione degli elementi geografici degli attributi. Esempi di queste elaborazioni sono: 

La sovrapposizione (overlay1) topologica: in cui si effettua una sovrapposizione tra gli elementi 
dei due temi per crearne uno nuovo (ad esempio per sovrapporre il tema dei confini di un parco con 
i confini dei comuni per determinare le superfici di competenza di ogni amministrazione o la 
percentuale di area comunale protetta). 

 

 

     

                                                 
1 Si riporta anche il termine inglese, perché molto usato in ambito GIS, tanto che spesso l'equivalente italiano non è 

neppure noto. 

Illustrazione 1: Operazione di 
esclusione 

 

Illustrazione 2: Operazione di 
sottrazione 
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Le selezioni spaziali, ovvero delle interrogazioni di dati a partire da criteri spaziali (vicinanza, 
inclusione, sovrapposizione etc.). Per esempio per selezionare le strade che attraversano un 
determinato comune partendo dalla carta della rete stradale di una provincia o di un comune. 

L'area cuscinetto (buffer): da un tema puntuale, lineare o poligonale definire un'area ad una 
distanza fissa o variabile in funzione degli attributi dell'elemento. Per esempio per creare zone di 
rispetto intorno ad un parco od ad un'area verde. 

 

 

 
 
 
 

L'analisi delle reti (network analysis): algoritmi che, a partire da una rete di elementi lineari (es. 
rete stradale) e da alcuni punti (ad esempio scuole), determinano i percorsi minimi tra due punti, 
oppure suddividono il reticolo stradale in aree di competenza, ecc. 

 

 

Illustrazione 3: Operazione di 
unione 

Illustrazione 4: Operazione di 
intersezione 
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Modelli spaziali: analisi per creare modelli che forniscano informazioni relative a quale parte del 
territorio sia migliore per un particolare tipo di intervento. Per esempio dove sarà meglio costruire 
la nuova scuola in base alle fermate degli autobus, alla stazione e alla disponibilità di parcheggi? 

 

 

 
 
 

 

Faremo ora qualche esempio di alcune analisi spaziali. 
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Selezioni geografiche 
Una delle operazioni più comuni è quella legata alla selezione spaziale ovvero alla selezione degli 
elementi di uno strato informativo in base ad un attributo geografico. Per vedere come effettuare 
un'operazione del genere avviamo QGIS, impostiamo l'unità di misura in metri e carichiamo il file 
Comuni_Lazio.shp. 

Poniamo di voler selezionare i comuni della Provincia di Roma e creare un nuovo strato vettoriale 
costituito da questi soli comuni. La prima cosa da fare è selezionare tali comuni a partire 
dall'informazione ad essa associata, se per esempio interroghiamo il comune di Roma vediamo che 
il campo COD_PRO (codice provincia) ha valore 58 e che quindi tale valore può essere usato per la 
nostra selezione. Dalla tabella associata usando la riga Cerca per posta in fondo ad essa possiamo 
effettuare una ricerca basata sul campo COD_PRO ed il valore 58 in modo da selezionare tutti i 
comuni della provincia di Roma. 

Verifichiamo che i poligoni identificati appaiano colorati in giallo chiaro, clicchiamo ora con il tasto 
destro del mouse sul nome dello strato in legenda scegliendo, nel menù a tendina che si aprirà, la 
voce Save selection as shapefile (Salva la selezione come shapefile). Nella finestra che si apre 
andrà definito dove e con quale nome (Provincia_Roma) salvare lo shapefile da creare, se 
l'operazione andrà a buon fine apparirà una piccola finestra con il messaggio Export to shapefile 
has been completed (L'esportazione dello shapefile è stata completata). 

Per valutare la buona riuscita della procedura si carica il file creato e si verifica che i comuni 
selezionati siano effettivamente tutti quelli della provincia di Roma. 

 

 

 

Per esercitazione si carichi lo strato Rete_Stradale.shp e si crei un nuovo file che contenga solo le 
strade di grande comunicazione (autostrade, superstrade...) identificate dal valore “0” nel campo 
FRC. 
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Altre operazioni spaziali 
Per effettuare operazioni spaziali più complesse occorre caricare un modulo aggiuntivo (detto 

plugin) di QGIS tramite l'apposita interfaccia; clicchiamo quindi sull'icona Install plugins  o 
selezioniamo il percorso Plugins → Plugin installer → Install plugins dalla Barra dei menù. 

L'interfaccia che si apre (QGIS Plugin Installer) permette di caricare sul nostro computer nuovi 
plugin dal sito web di QGIS (posto, ovviamente, che si abbia connessione ad internet). Clicchiamo 
quindi sul tasto Get list ed attendiamo che nel rettangolo sottostante compaia la lista dei plugins 
disponibili. Selezioniamo ora il plugin Geoprocessing e premiamo il tasto Install plugin , se 
l'operazione va a buon fine comparirà un messaggio come questo: Python plugin installed. Go to 
Plugins > Plugin Manager to enable Geoprocessing, premeremo quindi il tasto OK  sulla finestra 
di messaggio ed il tasto Fatto sulla finestra di installazione dei plugins. 

Nel caso in cui non fosse disponibile una connessione internet, decomprimere (unzippare) 
manualmente il file Geoprocessing.zip (presente sul CD) nella cartella C:\Documents and 
Settings\Nome_Utente del vostro computer dove Nome_utente è il nome della cartella base 
dell'utente in uso. 

 

 

 

 

A questo punto il plugin appena caricato va attivato e questo può essere fatto scegliendo il percorso 
Plugins → Plugin Manager... dalla Barra dei menù e seguendo le successive istruzioni nella 
finestra QGIS Plugin Manager che si aprirà. Vistate il plugin Geoprocessing nella lista presente 
nella finestra e cliccate sul tasto OK , anche in questo caso se tutto è andato a buon fine sarà 
comparso il percorso Plugins → Geoprocessing → Geoprocessing Tool nella Barra dei menù. 
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Sovrapposizione 
Nelle operazioni di sovrapposizione, come abbiamo visto nell'introduzione, si effettuano operazioni 
geometriche tra due strati vettoriali; per vedere come utilizzare tale funzionalità carichiamo lo strato 
prima creato relativo ai comuni della provincia di Roma e lo strato Fiumi_Principali.shp. 

Poniamo di voler selezionare i tratti fluviali dello strato Fiumi_Principali che attraversano la 
provincia di Roma; se apriamo la tabella associata allo strato Fiumi_Principali, notiamo che non ci 
sono informazioni relative alla posizione geografica dei fiumi e quindi non possiamo usare il 
metodo precedente, ma dobbiamo agire effettuando un intersezione tra questo strato e quello 
precedentemente creato. 

Per attivare tale plugin e aprire la finestra Geoprocessing si seleziona la voce Plugins → 
Geoprocessing → Geoprocessing Tool. Tale finestra permette di selezionare diverse operazioni 
spaziali e quindi non solo l'operazione di intersezione, ma anche le operazione di unione, 
sottrazione, dissolvenza, buffer e creazione di poligoni convessi. 

Vediamo ora come impostare tale finestra per effettuare la nostra operazione: selezioniamo nel 
menù a tendina dell'opzione Function la voce Intersection, nell'opzione Layer A lo strato 
Fiumi_Principali, nell'opzione Layer B lo strato Provincia_Roma e tramite il tasto Browse 
decidiamo la directory dove salvare il nuovo file. Premendo il tasto Ok l'operazione verrà eseguita, 
il nome del nuovo strato verrà dato in automatico come Intersection1.shp ed esso verrà caricato 
direttamente nell'area di mappa. 
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Se tutto sarà andato nel modo corretto vedremo il nuovo strato geometricamente identico allo strato 
Fiumi_Principali ma limitato all'estensione dello strato Provincia_Roma. 

Come prima esercitazione creiamo un nuovo vettore relativo alla rete ferroviaria (file 
Rete_Stradale.shp) della Provincia di Roma. 

Come seconda esercitazione poniamo di voler ottenere uno strato vettoriale relativo alle curve di 
livello dei parchi regionali partendo dagli strati Curve_Livello.shp e Parchi.shp. 

Generazione di aree di rispetto 
Tale funzionalità è conosciuta in ambito GIS come creazione di un buffer, ovvero di un area di 
dimensione definita dall'utente intorno ad ogni elemento dello strato vettoriale a cui la funzione si 
applica. 

Per analizzare tale operazione si caricano lo strato Laghi.shp ipotizzando di voler creare una zona di 
rispetto per tali aree. 

Per attivare tale analisi si apre nuovamente la finestra Geoprocessing selezionando la voce Plugins 
→ Geoprocessing → Geoprocessing Tool e si impostano le opzioni presenti in questo modo: 
selezioniamo nel menù a tendina dell'opzione Function la voce Buffer , nell'opzione Layer A lo 
strato Laghi, nell'opzione Buffer Distance il valore 5000 e tramite il tasto Browse decidiamo la 
directory dove salvare il nuovo file. L'opzione Dissolve Boundaries permette di evitare 
l'intersezione tra i buffer delle singole aree protette che potrebbe avvenire nel caso in cui queste si 
trovino troppo vicine, l'opzione farà si che in questo caso buffer di zone diverse si fondano un con 
l'altro. 

Premendo il tasto Ok l'operazione verrà eseguita; il nome del nuovo strato verrà dato in automatico 
come Buffer1.shp ed esso verrà caricato direttamente nell'area di mappa. 
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Come esercitazione effettuare la stessa operazione con un buffer di 5 km intorno a tutti i Parchi 
della Regione Lazio. 
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